Chapter 1 Introduction

The idea behind Proteus is to “wire up” connections between your ocean of corporate data and YOU, the one who needs to interact with them (read and/or write). This wiring process is carried out by a Proteus Administrator, and results in a so called “Workspace” with a given name. It defines the following things:

1. Which data the users can interact with (referred to as “DataSets”)
2. Access rights for who can read and/or write data back to source.
3. Access rights for who can save public Layouts/Lists (see chapter 6)
4. The internal hierarchical relationships between the DataSets.
5. How data for each DataSet is visually presented.
6. Calculated fields.
8. Which Completion Matrices are set up (see chapter 5).
9. Which “Watchdog Alerts” to monitor, and the response to give should they be triggered.
10. If and how reference data (snapshots) can be generated, and if and how this is used to provide change notification between current and stored reference values.
11. If and how data from a resident system should be “expanded” with user editable columns (and how this data is stored in separate database).
12. The Help information that is provided for the particular workspace.
13. How one or more custom user interfaces, DataLayouts, are produced.

Even though a workspace is set up by a Proteus Administrator, beyond the control of the user, there are many ways to customize it to be more tuned to personal preferences and professional needs. The last chapter (Chapter 6) will describe how this is accomplished.

In general this User Guide is geared towards a “how to”-format, where the Content page can act as a quick reference to get answers to frequently asked questions.
Chapter 2 Getting Started

Depending on how Proteus is deployed in your organization, you may need to do a couple of one time manual operations (supplying license key and/or selecting the Repository folder) to get Proteus up and running. They are described in Appendix B.

![Proteus Login dialog](image1)

Figure 1: The Proteus Login dialog where Workspace is chosen

![Splash screen](image2)

Figure 2: Splash screen shown during login

After filling in *Username* and *Password* with the credentials you were given (by Proteus Administrator), the list of your available *Workspaces* will appear in the dropdown list. Select the one you want and press OK (you choice is remembered next time you log on). A splash screen is shown while Proteus loads the data from selected Workspace.

**A note on the format of this document:**
In this User Guide, we will be using a Workspace called “Proteus Training” with limited data to make it easier to understand the concepts.
Chapter 3 Gantt Grid and Chart fundamentals

The Gantt Grid and Chart are commonly used elements of Proteus. The Grid allows sorting, grouping, aggregating, highlighting data, while the Chart allows for visual representation of objects as they appear in time.

The Gantt Grid and Chart are shown below in blue and red, respectively, but there is a 3rd important element called the “Filter Panel”, shown here in green. This is normally docked above the Gantt’s Grid and Chart, but it may be configured to be a part of the grid – as an extra row at the top.

In the following pages we will give names to other elements in a workspace, and look at what they can help you accomplish.

Figure 3: The initial form of the "Proteus Training" Workspace, and its 3 main areas.
The names of the screen elements

A. **DataSet selector** (tabs) – may be available both above and below Gantt Grid.
B. **Other tools** in Proteus toolbox - Dockable panels.
C. **Toggle button** controlling Gantt/Pivot mode.
D. **Save button** for committing data back to source.
E. **Layouts and Lists** – Dockable panels containing named items for customizations (Chapter 6).
F. Each item in E has its Public and Private lists of named elements.
G. **Selector of workspace**, when more than one is loaded.
H. **Menu items**.
I. Filter criteria display of **current filter for current DataSet**. Each DataSet has its own filter.

Figure 5: Layouts and lists pop up on demand at right

Figure 6: Bottom left corner has DataSet Tab selector (A), other Proteus Tools (B), Gantt/Pivot Toggle button (C) and Save Button when updating source data (D)
HOW TO: Filter Data

The filter may set up by Administrator to be part of each Grid, or (often) it is accessible as a separate filter panel (docked to wherever you wish, but normally on top of screen). Below is a list of options when filtering:

- A click here opens the list.
- List of recently selected single values.
- Opens dialog for custom column filter.
- List of unique single values (may be checkboxes instead by setting column properties).
- Clear filter for this DataSet.
- Enable/Disable the active filter.
- Pick from “Recently used filters”.
- Row of “filter boxes” for typing criteria.
- Launch of Advanced Filter Editor dialog (see next page).

**Note 1:**
When c is pressed, this dialog appears:

**Note 2:**
Proteus can (if set up by Proteus Admin) add an extra row in the grid that acts as a “parent” for any Orphan child objects. Its name will start with “Orphan_ “, and you may in some settings want to hide it using a filter (not like ‘Orphan%’).

The advanced filter editor

If you need more sophisticated filter settings, you can launch the Advanced Filter Editor by pressing the button. Here are some elements that need explaining:

1. Select Field to use (from list).
2. Select Operator from list.
3. Select compare Value OR Field.
**Note on 3:**
When the ![enter image description here](image1) is shown, a compare value may be typed but when clicked it changes to ![enter image description here](image2) and you may then select from the list of all available fields in DataSet.

Pressing the ![enter image description here](image3) will delete the item from filter.

**Combining AND or/or OR groups:**
You may wish to combine groups of field with “AND” conditions (they are all required to occur to pass filter), or you may want “OR” conditions, or perhaps a combination of both:

When the ![enter image description here](image4) is pressed this list appears:

It takes a bit of practice to master the art of setting groups as shown in figure above. It’s a good idea to try setting something in the Advanced Filter Editor, press Apply, and view the filter text string that it produces. There the **parentheses** may make things a bit clearer how things fit together. The specific setting above will result in the following filter criteria text:

![Filter criteria text](image5)

**Filter has hierarchical couplings (cascading effect)**

It is important to know that when two or more DataSets are related hierarchically (one parent record has a number of child records), then filtering the Parent will affect the children as well. The numbers in parentheses on tab of each DataSet show how many records have passed filter. In the example below, typing “Do” in the “des” field filter-box results in 2 activities passing filter, and this again affects the related child DataSets:

![Filtering ONE DataSet can affect how many records are shown in Child DataSets](image6)

*Figure 10: Filtering ONE DataSet can affect how many records are shown in Child DataSets.*
**HOW TO: Work with the Gantt’s Grid - Sort, Group, Aggregate Data**

**Sorting:**

Simply click the column header for which you want to sort, and click again for reverse order. Should you want to sort on more than one column, hold down the SHIFT-Key and press the 2nd column (and 3rd, etc). To remove a column from the multiple-column sort, hold CTRL-Key while pressing column header.

![Sorting can be done on more than one column](image)

**Grouping:**

Drag and drop any column you wish to group on to the area directly above the column headers:

![Grouping is accomplished by simply dragging fields to top section of grid](image)

You may group on as many fields as you like, and by clicking on the group field (see mouse arrow below), you will reverse the order of sorting for this group. Note that each group row may have a summary overview (E.g: “Sum Planned = 0”), and this has been set up by Proteus Administrator for the Workspace.

![Any number of fields can be used in grouping.](image)
**Aggregating:**

Right click in the footer bar of grid and select Aggregate function from list. See section on advanced grid properties for info on how to change the number format and the text prefixing the number (It will initially say “SUM=NN”).

![Figure 14: Right-click in grid’s footer to add aggregate summaries.](image)

**Selecting other fields from DataSet – The “Column Chooser”:**

The fields you see in grid are normally just a small subset of all available fields for DataSet. Most of them come from the DataSource (through SQL statement), but others are internally generated in different ways. In circled letter “B” below, you see the types of fields available in DataSet, and they may be turned on/off from the list in “A”. Fields from “A” can then be dragged across and dropped in the desired column position in Grid. The selection you make in “B” is remembered next time you bring up the Column Chooser.

![Figure 15: Right click anywhere in grid header, and then select “Column Chooser”. Drag fields to/from list and Grid.](image)

---

Proteus v1.7 User Guide  Page 10 of 34  12/2/2011
HOW TO: Set advanced properties in Grid

The dropdown menu that appears when you right click on any column header (see Figure above) has a choice called “Properties”. This is the entry point for setting a wide variety of properties relating to a column’s appearance and behavior. Let’s look at the dialog that appears when we choose it:

As you can see, at the bottom right section there is a useful description of the selected property.
Some useful properties to know about:

<table>
<thead>
<tr>
<th>Name of Property</th>
<th>Description of what it does and how to set it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caption</td>
<td>Sets the text in column header. See “Advanced feature” at bottom of this table for advanced formatting options.</td>
</tr>
<tr>
<td>DisplayFormat - FormatString</td>
<td><img src="image" alt="DisplayFormat" /> The value “2” in “(0:n2)” means 2 decimal places in number.</td>
</tr>
<tr>
<td>SummaryItem - DisplayFormat</td>
<td>Almost identical to the one above, but controls the formatting for aggregated value in footer.</td>
</tr>
<tr>
<td>AppearanceCell - BackColor</td>
<td><img src="image" alt="AppearanceCell" /> Setting a static background color. By setting BackColor2 you create a gradient transition.</td>
</tr>
<tr>
<td>ToolTip</td>
<td>Sets the tooltip shown when mouse hovers over column header. <strong>Advanced feature:</strong> There are some markup tags that can be used to set color, fontstyle and size to the text in column’s caption and tooltip:</td>
</tr>
</tbody>
</table>

**Example**

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;color=Red&gt;Some Text&lt;/color&gt;</td>
<td>Some Text</td>
</tr>
<tr>
<td>&lt;size=14&gt;Some Text&lt;/size&gt;</td>
<td>Some Text</td>
</tr>
<tr>
<td>&lt;b&gt;Bold Text&lt;/b&gt;&lt;i&gt;&lt;i&gt;...and italic&lt;/i&gt; Line1&lt;br&gt;Line2</td>
<td>Bold Text ..and italic Line1 Line2</td>
</tr>
</tbody>
</table>

These tags can be combined in any way you like. **Example:**

The <color=green><size=14><i>Green</i></size></color> giant

**Result:**

The **Green** giant

The best way to get more familiar with the possibilities for setting column properties is to go through them all, read the description, change some value, and see what effect they have in grid.
Conditional Formatting - Simple:

In Figure 15, you could also see a choice called “Conditional Formatting - Simple”. Selecting it brings up this dialog:

![Dialog for setting Conditional Formatting for a grid column](image17a)

**Explanation of annotations:**

A. Style conditions
B. Condition
C. Apply to entire row?
D. Style formatting

![Example result from left](image18b)

Conditional Formatting - Advanced:

Right click on any grid header (see Figure 15 above), you could also see a choice called “Conditional Formatting - Advanced”. Selecting it brings up dialog (fig. 18a below).

![Dialog for setting Advanced Conditional Formatting](image18a)

When the “+” sign is pressed at upper left corner of the form (see left), an expression editor appears that can help you create the expression to match your particular condition. It has a wide range of functions to choose from, each described when selected (see fig. 18b below):

![Conditional Expression editor](image19b)

The main difference between “simple” and “advanced” conditional formatting is that the simple version restricts you to show the coloring in the column being tested for a condition; whereas the advanced lets you color any column independent of the columns used in the condition.
Useful Notes on “Filter Grid”:

All of the properties that can be set for a grid-column, can also be applied to the Filter Grid. As mentioned before, this assumes that the Proteus Administrator has set up filtering in a separate panel instead of using the grid’s own filter.

Right-click on a column in filter grid will give the save “Properties” list.

In some cases you may not only be able to pick a single item from filter’s pick-list, but you want to select multiple items. This is achieved by setting the “FilterPopupMode” property to “CheckedList”. The images below reflect how this will appear to user:
HOW TO: Print Grid Gantt

Simply write click in grid and select “Export GridGantt”, then specify if you wish to show Gantt bars or not:

And here is the result:

Note: In the current version of Proteus, if you have grouping activated in the grid, you can’t show the Gantt Chart, only the grid.

From the menu you can export the result to various formats:
HOW TO: Modify data and save changes

Depending on your Access Rights, you may or may not be able to edit data. The right to modify data is two-fold:

1. A user may have the right to modify bars in Gantt Chart (drag and drop) and/or
2. A user may have the right to change data in Grid (other than the dates controlling bar range)

Move bars in Gantt Chart:

Figure 22: If given access, you may drag bars (either endpoint or whole bar) directly in Gantt Chart

A comment on the symbols at “a” and “b” in figure above:

At “a” the tooltip says: ![Range restriction: Finish date comes after Parent finish]

At “b” the tooltip says: ![Warning: Finish date is not a workday according to schedule]

It is possible for a Proteus Administrator to make visual indications if a child object is violating “Parent Range Restrictions”, i.e. that it is outside parent’s start-finish range.

In the example above, the parent’s range is shown as a red frame with its interior in cross-hatch if child is outside range (out of sync), and semitransparent red if within range. Any movements made to bar will affect these visual indicators dynamically (when bar has been edited).

Changing values in Gantt Grid:

An alternative way to move bars is to edit the start and finish dates from the Grid. When working with hierarchical child DataSet, you will find some extra choices when right clicking in any (child) row:

Figure 23: Hatch may represent: "out of sync"

Figure 24: Edit from grid
** Saving changes back to source  

If you are given access to update data, then pressing the button (at bottom left corner of screen) will bring up a dialog window showing rows that have one or more changed values:

![Confirm saving pending changes](image)

*Figure 26: See list of changed rows before committing changes back to source*

In order to accept the values that have red “Error Indicators”, you need to check the control called “Ignore Errors” before pressing OK.

If changes have been made to more than one DataSet, you will be prompted with the above dialog for each of the affected DataSets.

Note: The tab shown above called “SQL List” is only shown for admin users.
Chapter 4 Other Tools in the Proteus toolbox

Proteus is more than just an interactive Gantt Chart for hierarchical data – it has several other useful tools that could be considered “products” in its own right. There is a great synergy of having such a set of tools in conjunction with the data from all your sources.

HOW TO: Pivot Data

When the Gantt-Chart/Pivot-Chart toggle button is pressed (see circled icon above), the Gantt Chart will be swapped with a Pivot Grid+Chart. The Pivot Grid and related Chart are very useful tools for getting overviews over data, and they may save you from the habit of “cutting and pasting” data into excel when having to do pivoting of some kind in the future.

Important Note:
The data you pivot with are affected by the filter (see previous section).

Explanation to annotations in figure:
1. Select from over 30 Chart types.
2. Quick export to Excel or pdf.
3. The Aggregated Field(s).
4. The Row Field(s).
5. The Column Field(s).
6. The Chart.
7. Various Chart options.

The list of available field is accessible by Right-click in the top part of Pivot Grid and selecting “Show Field List”. You may notice that all date fields appear 4 times (one for the original field and three for Year, Month, and Week formatting). See figure at right.
HOW TO: Work with Time-phased data (Histogram)

The Proteus Administrator has defined which fields to time-phase in which DataSet. The spread is always linear, but the dates to spread between can be set up (by Admin) in these ways:

1. Start to Finish (normal)
2. Start to TimeNow (common for earned and expended values, since “work done” belongs to the “left” of TimeNow)
3. TimeNow to Finish (common for “Remaining” values – they belong to “the future”)
4. Two arbitrary date fields in a DataSet.
5. It is also possible to load data that is already time-phased and show it in histogram.

The Normal Histogram

![Figure 29: Time-phased result for multiple DataSets in “Normal” Histogram](image)

**Explanation to annotations in figure:**

1. The Bar-Chart showing time-phased result (periodic and cumulative).
2. Tabs for “summary Values overview” AND “control of Series Visibility”.
3. The Histogram Toolbar for controlling visible range, etc.
   a. Time Resolution (Normally Day, Week, Month).
   b. Unit (Normally Hours or Men).
   c. Visible range (the middle one reflect the selected date – set by click in chart and the values in right panel show the cumulated value to this date).
   d. Zoom control.
   e. Legend On/Off.
   f. AutoRefresh – if checked, the histogram will be updated when filter changes or a, b, c, and d above change their value.
   g. Refresh button (for manual refresh in case AutoRefresh is unchecked).
   h. Preview – show chart and/or grid in pdf format.
   i. Date Range (Choices: AutoZoom / WorkSchedule / EntireProject / Manual). If you manually select at start or finish date from the visible range (see c. above), this is automatically set to “Manual”.
4. The periodic values (can be exported by right-click menu choice).
5. Tabs for General and Split-Bar Histograms.
The Split Histogram

There are two tabs in the Histogram control, as seen in figure at left. By clicking on the right tab you can define a split histogram, but only for spreading value from ONE field in ONE DataSet, according to ONE split-field.

![Split Histogram Example](image)

**Figure 30:** Example of screen shot from a split-histogram showing day resolution.

The controls are identical to the ones for Normal Histogram, except for these:

- **DataSet:** Which DataSet to use as source.
- **Spread Field:** Which field in the selected DataSet to use. The spread-type (see previous page) for this field is the same as in Normal Histogram.
- **Split Field:** Which field should be used to “split the bars”?

![Histogram Controls](image)

The preview in pdf format. It may be exported to other formats, such as Excel, if needed.
This popup menu is shown if you Right-Click in grid below the histogram:

- Export to Excel
- Export to csv-file (transposed)
- Copy to Clipboard
- Show as Excel Graph

**Export to Excel**: The grid is saved as csv-file and opened in Excel. 
**Export to csv-file**: Same as above but grid is transposed. 
**Copy to Clipboard**: The selected cells are copied to clipboard. 
**Show as Excel Graph**: Creates the graph and grid as a chart with datatable in Excel. See figure below. This feature may, or may not, be set up in your particular setup of Proteus.

Grid and Graph can be exported to Excel, provided that a Proteus Administrator has set up this feature.
HOW TO: Work with the Completion Matrix

The “Completion Matrix” is a reporting format with an extremely high “information density”, and is very useful for getting good overviews on how things look from a “completion perspective”. In the example below the objects are located under the column that represent its finish week, and the colors indicate its Percent Complete (100%=green, 99-51%=yellow, 50-1%=orange, and 0%=red).

Figure 31: Completion Report showing Activities colored acc. to their banded Percent Complete value. Finish date of activity controls which column (week in example) it belongs to.

Explanation to annotations in figure:

1. Select which DataSet to use as source.
2. Select which predefined Report to use for the selected DataSet (see 1 above).
3. Select TimeUnit (set up by Proteus Administrator, but normally Day, Week, Month).
4. Set time-range to include in report (default is normally week as shown in figure).
5. The Cutoff time is highlighted (controlled by admin, but normally today’s date).
6. Objects (in this case Activities) are listed vertically under the column (week in the example) representing the one that they should be “completed” in.
7. Statistics for each column.
8. Tooltip can contain lots of information... even drill down into lower level DataSets
HOW TO: Work with “Watchdog Alerts”

The Proteus Administrator can define (in close dialog with the Project management team) which criteria to monitor and what alert message to give, should it be “triggered”.

There are very few technical limitations here – the challenge is to formulate all the conditions (inconsistencies between DataSets or plain errors) that your project wants to avoid.

The Watchdog Alerts showing below is an example from another workspace, and show the kinds of things your project may want to monitor.

![Watchdog Alerts Example](image)

Figure 32: Example of Watchdogs that “barked”. Details behind each are seen by double-click on an item in list

It is a good idea to undock this panel by holding mouse over the Alerts tab and dragging the whole panel upwards. Once you release it, you can again click on the GridGantt tab. If you Double-Click on one of the alert rows, you will apply a filter corresponding to the alert, and you will see the filtered data from the DataSet in question. In this way you can see all the details behind any alert that has been triggered.

HOW TO: Get info on workspace

Since each Workspace acts as an “application” in its own right, it is important to provide the user with information on how to use it properly.

The Information tab contains a browser control and is set up by Proteus Admin to contain help information, with possible internal hyperlinks or links to other related information.

Your project may also want to include information here on (or links to) best practices for performing certain tasks with your data.

*(The next page shows an example of the above.)*
Figure 33: Example of giving the user information on Workspace details

HOW TO: See activity log

If you press menu item “View – Log Info Panel”, you will see an activity log that may in some cases provide useful information, especially when communication with the Proteus Administrator to identify causes for unexpected behavior. Right-Click in this list shows a popup that allows exporting grid’s content to text file (csv-format) and showing it in Excel. The Proteus Administrator may request this list to be mailed to him/her should such an event occur.

Figure 34: An example of the activity log.
Chapter 5 Customize Proteus to your particular needs

Some users in a workspace will be given the right to save “Public customizations”, available to all users, but all users can have their “Private customizations”, available only to themselves. This chapter describes what things can be customized, and how easy it is to accomplish.

The following items can be saved: Filters, Screen Layouts, Grid Layouts, Pivot Layouts, Histogram Layouts, Completion Layouts, and Reports (combining a Layout and a Filter). These terms will all be explained in this chapter.

In addition to this, some users may have access to so called “Actions” that can publish data to specific locations. The “Action List” resembles very closely the list of the other items in this chapter, so is included here for that reason, even if it is not customizable in the same way at the others.

HOW TO: Save/Load various types of Layouts and Lists

With the exception of Filter List, Action List and Report List, all of the Layout categories will initially have a “[Default]” item both in the Public and Private branches of their “tree”:

By Right-Clicking under the Private branch, you will always get the popup-menu at “A”:

Doing the same under the Public branch may result in only “Load Item” showing – it all depends on your rights to save items under the Public branch.

Filter List:

Set the filter you want by using the filter functionality shown in Chapter 4, and then right click in either Public (provided you have access) or Private branch and press “Add Item” – fill in Name and Description, and press OK:

Holding mouse over an item in tree will show a tooltip with Name and Description, as well as who created it and when. Filter is applied by simply Double-Clicking item in tree, or by right clicking and selecting “Load Item”.


**Report List:**

A Report is simply a combination of a Filter and a Layout that is given a name and a description. By pressing “Add Item” or “Edit Item”, you will launch the “Report Wizard”, where your first choice is what kind of predefined report layout to use as a template for your report. Depending on the type you choose, you will be guided through some additional pages where you have to select settings that you want.

![Figure 36: The first page in wizard](image1)

In the final page (see figure at right) you will have to give the report a name (unique) and a description. You can also write the title you wish to show in the report, as well as watermark (if any) with text and transparency.

![Figure 35: The page where destination is chosen](image2)

In the ReportList, icons will indicate what type of report it is and what destination has been chosen for it (screen, printer, mail, and file).

A separate document describes how to use the Proteus Report Designer.

![Figure 37: The final page of the wizard](image3)

**Action List:**

This is set up by Proteus Administrator, and normally only a select handful of people would see anything in this list (see right).

A Double-Click on an item will give a confirmation dialog before the action is carried out.

![Figure 38: Confirmation dialog for Action](image4)
**Grid Layout:**

When a Grid Layout is saved, quite a few things are saved with it besides the layout of the grid:

1. The layout of the Card-View (see earlier section).
2. The layout of the filter grid above it (if made visible to users).
3. The splitter position between Gantt-Grid and Gantt-Chart.
4. The state of the Gantt/Pivot toggle-button

For the grid(s), every property that is set for any column will be saved: Column widths, captions, tooltips, number formatting, conditional formatting, aggregate summaries, grouping levels, sort orders, Custom Column Editors etc.

The Proteus Administrator can allow the Private “[Default]” layout to be used, if defined, and of newer date than the Public one. This is a choice your team, in collaboration with Proteus Administrator, has to decide on.

**Screen Layout:**

All the panels in Proteus are Dockable, which means that they can be “detached” from their resident location and moved or docked elsewhere. Undocking a tool is done by simply holding on the panel’s tab and dragging it away from its original location. Placeholders will appear that indicate where it can be docked, or you can leave it undocked – as a separate “window”. This is especially interesting if you have 2 screens next to each other - you may have some tools constantly visible on the left screen, and others on the right. Or even if you only have one screen, you may want to have some tool-windows alongside each other:

![Screen Layout Diagram]

**Figure 39:** Customize the arrangement of tools and give this arrangement a name for quick retrieval

If a tool-window is floating on screen, it can be returned to its docked position by double-clicking on its top part. Conversely, double-clicking the tab in its docked state will return it to its previous “floating” location.

In figure above we see that Gantt’s Grid and Chart (“A”) can be seen together with Histogram (“B”) and Information(“C”). The rest of the tools are still available in the shared space of “A” by selecting any of the 4 tabs for the remaining ones.
How to turn AutoHide on/off for a Panel:
Below you see the “normal” look of the Layout and List panels. When the mouse is moved over one of its tabs, it will “pop-out” from its hidden state, and when mouse clicks outside the area, it will return to hiding. If you want to make it “Always Visible”, then simply press the “pin” icon. Notice that the tabs will then move from the right side to the bottom.

Pivot Layout:
When a Pivot Layout is saved, these things are persisted:

A. The Chart Type and checkbox-states.
B. The Fields used in the Pivot Grid.
C. The splitter position (as height %) that separates the grid from the chart.
**Histogram Layout:**

When a Histogram Layout is saved the following things are persisted:

A. Which type of Histogram Report to show (Normal or Split-Bar)
B. Which series to show.
C. The horizontal split percentage.
D. The vertical split percentage.
E. The control settings of TimeResolution and Unit.
F. The control settings for the Split Histogram.

![Screenshot of Histogram Layout](image)

**Figure 42:** Items that are persisted in a Histogram Layout

**Completion Layout:**

When a Completion Layout is saved the control settings of top row is persisted:

**DataSet:** Which DataSet to use.

**Report:** Which predefined report template to use from this DataSet.

**TimeUnit:** The time resolution.

**Note:** The timerange is not saved – report will always use the time-span defined by the filtered objects.

![Screenshot of Completion Layout](image)

**Figure 43:** The 3 leftmost controls at top are persisted in Completion Layout
Data Layout:

This feature was introduced in Proteus v1.6 and opens the possibility to create virtually any kind of user interface to go with your data. At a user level, it is possible (if access is granted) to right click on the form and choose “Customize Layout”.

Controls can then be rearranged on screen (see figure 44 below), by drag and drop, or new controls can be dragged in from the Layout Tree List (see figure 45 below).

Figure 44: Any kind of dashboard can be created in Proteus by a Proteus Administrator, and the users can make customizations to how it looks – to be saved as a private layout, or (if access is given) to a public.

Figure 45: Controls can be dragged from left list, or properties can be set for selected controls (at right)
### Menu items

![Menu Items](image)

Let’s get a quick overview of the menu item, going from left to right:

**The File menu:**
As mentioned before, it is possible to have more than one Workspace open at one time. A new session is launched with File – New – Session (or Ctrl+Shift+N).

**The View menu:**
This is useful if one of the Dockable panels have been “closed”, i.e the at top right corner of the tool has been pressed. By clicking on an item in the list (see figure at right) it will reappear as visible.

**The Tools menu:**
A brief explanation for the items under the Tools menu (if rights are given to this):
1. Query Analyzer – Allows viewing SQL behind each DataSet, and test modifications.
2. Save and restore Grid Layout from/to file. Can be useful to “copy” layouts.
3. Copy all the column widths, captions, and tooltips from Grid to Filter Grid.
4. Export all DataSets to MSAccess database. It will be created on the user’s temp path (Start-Run-%temp% to see folder) as “ProteusPDSExport.mdb”.

**The Window menu:**
By unchecking “Use TabbedMDI”, each workspace will become its own window instead of a tabbed page. This may be useful if you need to compare two instances of the same workspace, or have 2 separate workspaces on 2 different screens.

**The Skin menu:**
This is another way to customize the “look and feel” of Proteus. This setting is remembered and used for all your workspaces (until changes).

**The Help menu:**
This shows an “About Proteus” form as in figure at right. There you find version number and license information.
### Appendix A: Internally generated fields

In a grid’s “column chooser”-list you will see a (long) list of fields. Most of them will probably come from the grid’s DataSource (normally through an SQL statement), and some will be set up by Proteus Administrator as calculated fields, and then some are internally generated.

List of internally generated fields, and what they mean:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ParentStart</td>
<td>System.DateTime</td>
<td>The Parent’s Start Date</td>
</tr>
<tr>
<td>_ParentFinish</td>
<td>System.DateTime</td>
<td>The Parent’s Finish Date</td>
</tr>
<tr>
<td>_ParentID</td>
<td>System.String</td>
<td>The Parent’s Unique ID</td>
</tr>
<tr>
<td>_ParentDescription</td>
<td>System.String</td>
<td>The Parent’s Description</td>
</tr>
<tr>
<td>_ProgressDate</td>
<td>System.DateTime</td>
<td>The date corresponding to tip of progress bar</td>
</tr>
<tr>
<td><em>Original</em>&lt;_StartColumn&gt;</td>
<td>System.DateTime</td>
<td>The original start date, internally used for restore</td>
</tr>
<tr>
<td><em>Original</em>&lt;_FinishColumn&gt;</td>
<td>System.DateTime</td>
<td>The original finish date, internally used for restore</td>
</tr>
<tr>
<td>_ExpectedProgress</td>
<td>System.Double</td>
<td>The expected progress acc. to TimeNow</td>
</tr>
<tr>
<td>_OnSchedule_Start</td>
<td>System.DateTime</td>
<td>The start date if it had been on schedule</td>
</tr>
<tr>
<td>_OnSchedule_Finish</td>
<td>System.DateTime</td>
<td>The finish date if it had been on schedule</td>
</tr>
<tr>
<td>_OnSchedule_Offset</td>
<td>System.Int32</td>
<td>The number of days to move to be on schedule</td>
</tr>
<tr>
<td>_IsInWorkSchedule</td>
<td>System.Boolean</td>
<td>True if within the work-schedule range</td>
</tr>
<tr>
<td>_ChildCount</td>
<td>System.Int32</td>
<td>The number of child-rows. If more than one set of child-data exists, the second set will be called _ChildCount2, the etc.</td>
</tr>
<tr>
<td>_HasShadow</td>
<td>System.Boolean</td>
<td>True if the row has a related shadow row. If more than one set of child-data exists, the second set will be called _HasShadow2, the etc.</td>
</tr>
<tr>
<td>_IsOrphan</td>
<td>System.Boolean</td>
<td>True if parent is missing. In such a case the object’s Description Field will start with “Missing Parent: &lt;Name of the parent not found&gt;”</td>
</tr>
<tr>
<td>_Duration</td>
<td>System.Int32</td>
<td>The number of days between start and finish dates.</td>
</tr>
<tr>
<td>_WorkDays</td>
<td>System.Int32</td>
<td>The number of working days between start and finish dates, according to the calendar that the object is assigned to.</td>
</tr>
</tbody>
</table>
Appendix B: Setting License Key and Repository Folder

First time Proteus is run, you may have to do one or two one-time operation to get Proteus started. Both of these are described in this appendix.

Providing a License Key:
Depending on how your IT department has decided to deploy the application, the license key may, or may not, be automatically inserted on your local machine’s registry.

If this is not the case, the following dialog will be shown the first time the application is started, and you will need to enter the license key given by the vendor, and press “Validate Online Now”. After a second or two, you can press “Accept”, and you never have to enter this again.

Selecting a Repository Folder:
Depending on how your IT department has decided to deploy the application, the Repository Folder may, or may not, be automatically inserted on your local machine’s registry. If this is not the case, you need to manually specify this folder (you should have been given this information from your Proteus Administrator).
Copyright © 2011 Promineo

All rights reserved. No part of this publication may be reproduced in any manner without the prior agreement and written permission of the publisher.

Published by: Proteus Development Team, Eiganesveien 8, Stavanger, Norway

Date: October 2011

Feedback: We always try to improve our product, including its documentation. Please feel encouraged to report any errors or other feedback regarding this document to: proteus@prominea.no